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Usage Rights and Restrictions
You may:

Copy the CDs on one computer hard drive and use the images on that computer.

Use, copy, modify and publish any of the digitized images contained in the program
for use in advertisements, newsletters, public, private and business presentations,
and other uses, provided the actual images are not being sold. For example, you can
use the image(s) as an embedded image(s) in the program such as a background
screen, but not as a program file, such as a .PCX or other picture format.

Use the images to create calendars, greeting cards, posters or other items which are
not intended for sale.

Use the images as part of a software product, provided the user does not have
access to the actual image files.

Use the images to create calendars, greeting cards, posters or other items which are
intended for sale. For example, if you create a sports calendar using images found in
the photo CD and intend to distribute and sell these calendars, this is a violation of
the license agreement.



Usage Rights and Restrictions (Cont’d)
You may not:

Make copies, film negatives or positives, magnetic copies
of the images of the CDs for sale, rental, lease, or transfer
to another person or entity, other than the permitted user.

Distribute any of the images as part of any software prod-
uct(s), in electronic file formats such as .PCX, .WMF, .BMP,
.EPS, .PICT, etc.

Copy the program(s), alter, modify or adapt them.

Copy, decompile, disassemble, modify, translate or create
derivative programs based on the applications embedded
in the program(s).

Use or alter, in whole or in part, a digitized image in any manner for pornographic
use.



Additional Information
The following categories are listed in the Kudo Browser:

• Borders

Expert Software recommends that the .WMF format is utilized for clearer resolu-
tion and optimal resizing capabilities. To use the .WMF images, go to the d:\con-
tent\.wmf directory (where d:\ is the drive letter of your CD-ROM).

Note: you must have a .WMF filter or an application that is able to open a .WMF
format file to view these images.
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Program Overview

Learn registration procedures, installation
instructions, and how to get started using
Kudo Catalog Reader.

Welcome to Expert’s Image Collection!
This collection contains numerous images which can be used in a
variety of documents. This online manual contains instructions for
using the images in a variety of programs as well as how to use the
Kudo Catalog Reader to print and preview the images before placing
them into a document. This chapter covers registration procedures,
installation instructions, and how to get started using the Kudo
Catalog Reader.
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Registration
By registering, Expert Software, Inc. can keep you informed of the latest changes
and improvements to this product, as well as information on our other products.
Sending in your registration card also allows you to receive free product support.

In order to register this product, either fax via modem or print the registration form.

Note: If you did not register during installation, you need to re-install the program
in order to redisplay the Expert Software Registration Card.

To fax your product registration using the modem:

1. Fill out the appropriate information in each field.
2. Click on the COM Port section field to display a
list of available ports.
3. Select the appropriate Port for your computer.
4. Click on the Fax Card button to transmit the
information.

TIP: if you don’t know what Port your fax,modem
is connected to, try a different COM Port number.
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If you prefer, you can print the registration card and print it by clicking on the Print
Card button. Fax the printed form to: (305) 569-1360. Or mail it to:

Mail to: Expert Software, Inc.
P.O. Box 144506
Coral Gables, FL 33114-9796

Fax it to: (305) 569-1350
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Starting the Online Catalog
When you register the program, the Online Catalog will be installed. To access the
Online Catalog which allows you to preview other exciting Expert products:

Windows ® 95 users

Insert the Expert CD into your CD-ROM drive. On the Taskbar, click on the Start
button, point to the Programs folder and the Cartoons Clip Art folder and finally,
point to and click on Expert Online Catalog .

Windows ® 3.1 users

Insert the Expert CD into your CD-ROM drive. Locate the Cartoons Clip Art pro-
gram group and maximize or double-click on the Expert Software icon. Once it
opens, double-click on the Expert Online Catalog icon.

Microsoft Video for Windows

To launch the installation of Microsoft Video for windows, choose File—Run then
go to d:\MVFW\setup . Watch an overview of the program by running Cartoons.avi
located in the Expert folder.
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Installing TrueType Fonts in Microsoft® Windows®

1. Place the Expert CD into your CD-ROM drive. From Microsoft® Windows®

Program Manager, double-click on the Cartoons Clip Art Fonts icon located in
the Cartoons Clip Art program group. The Fonts dialog box will appear.
2. Click on the drop-down list box and select a Font Family . All the fonts for that
family are displayed in the larger box.
3. After highlighting
the desired fonts,
click on the Install
Selected Fonts but-
ton.
4. To make multiple
font selections, press
the CTRL key while
you click on the
desired fonts.
5. After installing the
desired fonts, this
window appears to
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confirm your selection. Click
on the OK button.

Note: it is recommended that you do not have more than 20 fonts installed on your
system at one time. For Win 95 users, after installing the fonts, click on the Fonts
icon in the Control Panel to update the fonts folder. All fonts will be visible in the
application.

Installing TrueType Fonts in Macintosh®

1. Quit all running applications
2. Insert the CD into the CD-ROM drive.
3. Double-click on the MAC TrueType® Folder.
4 Shift-click on each desired font and drag it onto the Systems/Fonts Folder.

Please note: all other commands are identical for Macintosh and Windows users.
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Terminology used in this manual
Please note, Note, Hint, or Tip: Additional or background information on a com-
mand or procedure.

Choose File—Open : Choose a command from the applicable menu item. In this
case, the command means to go to the File menu and select the Open command.

1, 2, 3, etc. : Sequential steps that are numbered in order of execution. Start with
step 1 and proceed through the next step in order to complete the procedure
being described.

Drag & Drop : Press and hold the mouse button, then drag or move the mouse.
Release the button when the movement is finished.

Control Menu Box : The hyphen-shaped icon is located in the upper left corner of
dialog boxes and windows. By double-clicking on the icon, you will close the cur-
rent application. This functions as if you had pressed the ALT key and the F4 key
at the same time.
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Using Kudo Catalog Reader
The Kudo Catalog Reader enables you to open catalogs of images in various dis-
tinct categories. Each category is a separate catalog. The Kudo Image Browser
catalogs the image files using thumbnails. Think of a thumbnail as a miniature
photo of the image file. It looks like the file, but it's a replica that takes up very little
memory. Kudo uses the thumbnail in its catalog and leaves the image file
untouched in its original form and location. With these compact thumbnails, Kudo
catalogs the image files in a convenient, accessible way.

The thumbnails provide a visual reference for each image file. Kudo adds informa-
tion, such as the original file’s name, location, size and file type to complete the
catalog.

The Kudo Catalog Reader Window

Kudo allows you to view image thumbnails in three ways: gallery, small gallery,
and list views. This is a typical Kudo Catalog Reader window. The catalog selected
is being displayed in the Gallery View.
Please note: the Kudo Catalog Reader displayed is an example and may not
reflect your onscreen images or the categories available on your CD-ROM.
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1. Small Gallery View Button - The Small Gallery View uses the same layout as
Gallery, but with much smaller images. This allows the user to view more
images at once.

2. Gallery View Button - The Gallery View uses a grid-style layout showing sever-
al thumbnails and their file type and size at once. Click on the Info button to
view more detail about the selected thumbnail.

3. List View Button - List View uses a vertical layout with fewer thumbnails in the
window, but with a notes section for each file. The List View displays the thumb-
nails in a vertical column and the blank notes section in a second vertical col-
umn.

4. Find Button - Use the Find feature to search the catalog for thumbnails with
specific characteristics. Kudo searches the catalog and displays the thumbnails
that were identified in the search. All other thumbnails are hidden from view.

5. Info Button - The Info button gives you quick access to a thumbnail's informa-
tion. This option tells you the filename, volume, size, date, location of file and
any notes attached to the thumbnail. Note: the date, volume and notes will
most likely contain the same information for all images. Also, the notes section
is blank for the images in the catalog.
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6. Menu Bar - The menu commands allow you to access all the main program
features.

7.Thumbnail - A thumbnail is a small picture of your original file. Thumbnails
allow you to preview your image before selecting it. Select a thumbnail by click-
ing on it once.

To open a full-screen preview of the image, choose Image—Display Original.
To open the thumbnail into a Paint program such as Microsoft Paint, double-
click on the thumbnail. Note: this will only work if the thumbnail image format
(.BMP, .PCX, .TIFF, .WMF, etc.) has been associated with the Paint program
application.

8. Image Information - This area displays the file name and size of the original
image. Note: this area is only visible in the Gallery View.

9. Riffle Feature - The Riffle feature displays the selected catalog's thumbnails
one at a time in the lower right corner of the main window.
To control the Riffle speed and direction, hold down the left mouse button and
drag the control bar from the center to the left or right of the Riffle Control. Kudo
advances through the catalog until you release the control or until it reaches
either end of the catalog.
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When the mouse button is released or the control bar is returned to the center
position, Kudo stops near the thumbnail that you choose and displays the sur-
rounding thumbnails.Your reactions may be slower than Kudo's Riffle feature,
so when you release the Riffle control, you may have to select a thumbnail that
is a few frames ahead of the one you want.

10. Status Bar - The Status Bar displays the number of thumbnails currently dis-
played out of the total number of thumbnails contained in the active catalog.
For example, the active catalog contains 13 thumbnails which is displayed as
"13 of 13 found." After executing the Find feature for all images whose name
contains the letter "B" for example, only 3 thumbnails meet the search criteria.
The Kudo Browser window only displays the 3 found thumbnails and the
Status Bar displays "3 of 13 found."

Use either the Find All option from the Image menu or find "Everything" using
the Find button.

Please note: the “Read Only” message on the status bar indicates that the
images in the catalog cannot be modified.
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Tools/Toolbars

This chapter details the tools accessed
from the Kudo Catalog Reader’s toolbar.

Small Gallery View button
The Small Gallery View uses the same layout as Gallery, but with much smaller
images, allowing the user to view more images at once. The filename is not dis-
played in this view. Click on the Info button to view detail about the selected
thumbnail. This command can be activated by choosing View—Small Gallery .

2
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Gallery View button
The Gallery View uses a grid-style layout showing several thumbnails and their file
type and size at once. Click on the Info button to view detail about the selected
thumbnail. This command can also be activated by choosing View—Gallery .

List View button
List View uses a vertical layout with fewer thumbnails in the window than the
Gallery View and a blank notes section. The List View shows the thumbnails in the
first vertical column and the blank notes section in a second vertical column.
Simply click on one of the three View buttons to toggle to the view desired. This
command can also be activated by choosing View—List .
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Find button
Use the Find feature to search the catalog for thumbnails with specific characteris-
tics. Kudo searches the catalog and displays the thumbnails that were identified in
the search. All other thumbnails are hidden from view. When you click on the Find
button (or choose Image—Find), Kudo displays the Find Image dialog box.

1. Use the first combo box to tell Kudo which thumbnail characteristic it should
search.You can search by name, size, date modified, notes or location. Note:
images in a catalog only have a distinct name and size, all other characteristics
are the same.
2. Use the next combo box to tell Kudo how to search the catalog. The selections
in this combo box will appear after you make a selection in the first combo box.
3. The Edit Text box tells Kudo what words or information to search for. Wild Card
characters such as * or ? are not necessary. Enter or type text into this box.
4. Click on the Find button. Note: when you exit from the catalog and reopen it, all
images in the catalog will be found.
Note: To revert to all images in the category, choose Image—Find All .
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Info button
The Info button gives you quick access to a thumbnail's information. This option
tells you the filename, volume, size, date, location of file and any notes attached to
the thumbnail.

Note: The date, volume and notes may contain the same information for all
images. The notes section may also be blank.

To display a thumbnail's information:

1. Highlight a thumbnail by clicking on it.
2. Click on the Info button.
3. Kudo displays the information in a floating window called Image Information.
4. To close the window, double-click on the Control Menu box (the hyphen-shaped
box in the upper left corner of the window).

Hint 1: to view the image information on another image without having to close
the floating window and reopen it, simply click on another thumbnail.
Hint 2: none of the information in this dialog box may be changed because the
catalog is Read Only.
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Menus

This section of the Online Manual
describes the functions of the menu com-
mands.

File Menu
The File menu contains the commands for opening, closing,
printing, printer setup and exiting from the Kudo Reader.

Open (Ctrl+0)

To open another Kudo Catalog within the current Kudo Reader,
choose File—Open . This option displays the Open dialog box.
Select the CD-ROM drive and open the win_kudo directory.
Select one of the .kdb (Kudo Database files) listed and then
click on the OK button. The selected catalog opens in the same
screen as the current catalog. See the Window menu for addi-
tional screen display options.
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Close (Ctrl+W)

To close the currently selected catalog, choose File—Close. This option allows
you to save memory and close a catalog without exiting from the Kudo Catalog
Reader.

Print (Ctrl+P)

Use the standard Printer Setup and Print commands to print part or all of your cat-
alog. The Print feature always prints the current selection of thumbnails. For exam-
ple, to print all thumbnails in a catalog, choose Image—Find All to find every-
thing, then choose File—Print .

To print thumbnails with file name and size only, select the Gallery View prior to
printing your catalog. Printing a catalog in Small Gallery View prints the maximum
number of thumbnails per page.

To switch between views, click on the View button you prefer before printing a cat-
alog in the Gallery View, Small Gallery View or List View.
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Printer Setup

Printer Setup allows you to select available printers and change their options.

After choosing the menu command:

1. Select a printer and port from the Drop-down Combo box.

2. Click on the Setup button to open the Setup window and choose the print qual-
ity, paper orientation and size.

3. From the Setup window, click on
the Options button to choose
additional printer-specific options.

4. Click on the OK button on each
window to accept the changes.

Exit (Alt+F4)

The Exit command closes all open catalogs and then closes the Kudo Catalog
Reader.
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Edit Menu
The Edit menu contains one grayed-out, inaccessible command
called Copy Text. Copy Text is unavailable because all of the cata-
logs are Read Only. Only the Copy Thumbnail option is accessible.

Copy Thumbnail (Ctrl+C)

Copy Thumbnail copies the selected thumbnail in the currently active catalog to
the Clipboard viewer. Once an object has been copied to the clipboard, it is simple
to Paste the image into another application. Please note: The actual image, not
the thumbnail will be copied to the clipboard.

To retrieve the object from the clipboard, choose Edit—Paste from the menu of
the target application.
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View Menu
The View menu allows you to choose from three viewing options:
Gallery View, Small Gallery View and List View.

Note: The grayed out option is the active one.

Small Gallery (Ctrl+S)

The Small Gallery View uses the same layout as Gallery, but with much smaller
images, allowing the user to view more images at once. The filename will not be
displayed in this view. Click on the Info button to view detail about the selected
thumbnail. This command can also be activated by clicking on the Small Gallery
View button.

Gallery (Ctrl+G)

The Gallery View uses a grid-style layout showing several thumbnails and their file
type at once. This command can also be activated by clicking on the Gallery View
button.
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List View (Ctrl+L)

List View uses a vertical layout with fewer thumbnails in the window and a blank
notes section appears next to the thumbnail. The list view shows the thumbnails
in the first vertical column and the notes section in a second vertical column. This
command can also be activated by clicking on the List View button.

Please note: the information in the List View cannot be edited because the infor-
mation resides on the CD not on your hard drive. In other words, the catalog is
Read Only.
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Image Menu
The Image menu provides options on finding, pre-
viewing and getting information for your selected
thumbnail.

Display Original (Ctrl+E)

Kudo maintains a link between the thumbnail image in
the catalog and the original file. Use the Display Original option to preview the origi-
nal image file in a full-sized window.

1. Select the thumbnail you wish to preview.
2. Choose Image—Display Original .
3. Kudo finds the original image file and display it in a full-sized window.
4. Double-click on the Control menu box (the hyphen-shaped box in the upper left
corner of the window) to exit the preview window.
To preview other image files, simply click on their thumbnails while the Display
Original Image window is open.

Note: if the Find Image window appears, place the letter of your CD-ROM drive in
the text field and then press the return key.
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Get Info (Ctrl+L)

Get Info gives you quick access to a thumbnail's information. This option tells you
the filename, volume, size, date created, location and any notes attached to the
thumbnail. This option can also be
activated by clicking on the Info
button. Note: Usually, only the
name and size are distinct for each
thumbnail. This information cannot
be changed as it resides on the
CD, not on your hard drive. To dis-
play a thumbnail's information:

1. Select a thumbnail.
2. Choose Image–Get Info .
3. Kudo will display the information
in the floating window called Image
Information.
4. Double-click on the Control
Menu box (the hyphen-shaped box
in the upper left corner of the win-
dow) to exit the floating window.
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Find (Ctrl+F)

Use the Find feature to search the catalog for thumbnails with specific characteris-
tics. Kudo searches the catalog and displays the thumbnails that were identified in
the search. All other thumbnails are hidden from view.

When you select the Find button (or choose Image—Find ), Kudo displays the
Find Image dialog box.

1. Use the first combo box to tell Kudo which thumbnail characteristic it should
search.You can search by name, size, date modified, notes or location.

Note: a distinct find may not be available for all of the above characteristics.

2. Use the next combo box menu to tell Kudo how to search the catalog. The
selections in this combo box will become available after you make a selection
in the first combo box.

3. Use the Edit Text box to tell Kudo for which words or information to search. Wild
Card characters such as * or ? are not necessary. Enter or type text into this
box.

4. Click on the Find button.
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Find All (Ctrl+A)

Find All searches for and displays all thumbnails in the active catalog. This feature
is also used to restore all thumbnails after a Find operation. Find All is the equiva-
lent of executing a Find Everything by clicking on the Find button.

Sort Menu
The Sort menu allows you to sort thumbnails according to the following
criteria:

Name sorts by an eight character file name.
Size sorts by the actual image file size (bytes).
Kind sorts thumbnails alphabetically by their image type (extension).
Modification Date sorts by the date the image file was last modified.
Location sorts by the image file's location (pathname).
Notes sorts by the first word in the notes box.

To start a sort, simply choose one of the six commands in the menu and
the program will automatically start sorting the images in the order of the chosen
command. Note: only sorting by name and size produces a unique sort. In most of
our products, all other characteristics are identical for all images in the Kudo
Catalogs.
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Window Menu
The Window menu allows you to manipulate the currently displayed win-
dow with the following standard Windows options:

Cascade arranges open windows so that the title bar of each window is
visible
Tile arranges open windows side-by-side so that all of them are visible.
Arrange Icons arranges all program-item icons for a selected group into
rows.
Close All closes all open catalogs.
Document List lists the names of all currently open browsers.

Note: these options are only useful if you have more than one Kudo *.kdb
opened at one time. Click here to jump to the Open command in the File
menu for further information.
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Help Menu
The Help menu allows you to launch an online help file containing
instructions on how to use this program as well as credits for this pro-
gram.

Index launches Expert’s Online Help file.

Using Help launches the Windows Help on Help file.

About launches the Kudo Catalog Reader About box.
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Tutorial

Learn how to place the clip art images
while using Kudo. Tips for inserting the
images in various applications are also
covered in this section.

Placing Images Via Kudo
Through the Kudo Reader, users are able to preview
the images as well as place them into other applica-
tions. There are two methods for placing an image from
a Kudo Catalog into a document:

1. Copy and Paste
2. Drag and Drop
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Copy and Paste

1. Choose Edit—Copy Thumbnail to copy the selected thumbnail in the currently
active catalog to the Clipboard Viewer.
Note: once an object has been copied to the clipboard, it is simple to Paste the
image into another application. The actual image, not the thumbnail, is copied to
the clipboard.

2. To retrieve the object from the clipboard, choose Edit—Paste from the menu of
the target application.

Drag and Drop

Kudo takes advantage of Windows technology (DDE and OLE 2.0) which allows
you to Drag and Drop images into all popular graphics applications. When you
Drag and Drop from your Kudo catalog to an open document, Kudo will find the
original image file and place it in the document of selected desktop publishing and
other page layout applications, with pinpoint accuracy.
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To Drag and Drop a thumbnail to an open document:

1. Open the Target Document and open the Kudo Reader. Size both applications,
so that they can both be seen on the screen.

2. Select the thumbnail to be moved to the target document.

3. Hold down the mouse button and drag the image to the open document. The
cursor will change when you are able to drop it onto the document. If an "X"
appears on the cursor, you cannot drop the thumbnail onto the target docu-
ment.

The following applications support Drag and Drop:

• All graphics applications support Drag and Drop from the File Manager. This
includes virtually all leading applications.

• All graphics, desktop publishing, and multimedia applications that are OLE 2.0
clients. OLE 2.0 clients provide pinpoint accuracy when dropping onto a page
layout.

• Kudo includes Place Modules for the following applications that are not OLE
2.0 clients, but could benefit from Drag and Drop with pinpoint accuracy:

QuarkXPress® version 3.12. 3.2 and 3.3
Adobe® PageMaker® version 4.2 and 5.0
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Microsoft Word® version 2.0*
WordPerfect® 6.0

Note: for Microsoft Word users, Word will indicate that you can drop the image
only when the cursor is over the Word application toolbar or status bar (along
the bottom of the window). When the image is dropped, it will be inserted at
the exact location of the Word "I-beam" (insertion point). Release the mouse
button and Kudo will find the image and place it into the document.

Using the Images in Various Applications
The following programs are covered in this section: Aldus PageMaker, Harvard
Graphics, Microsoft Word, Word Pad, Write and WordPerfect. Please see the man-
ufacturers’ user guides for more detailed information on using the images with
other programs.

Microsoft ® Write (Windows ® 3.1)

1. Open or create a Write document.
2. Choose Edit–Insert Object .
3 Select Bitmap image in the Drop-down menu.
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If you have any questions, call Microsoft Windows support.

Microsoft ® Word Pad (Windows ® 95)

1. Open or create a Word Pad document.
2. Choose Insert–Object .
3. Select Bitmap image in the Drop-down menu.
If you have any questions, call Microsoft Windows support.

Microsoft ® Word ® 6.0 and 7.0

1. Open an existing Word document.
2. Choose Insert–Picture .
3. In the dialog box that appears, change the drive and directory to locate the
image. All of the images for the Kudo Catalogs are located on the Expert CD.
4. Select the image you want to use and click on the OK button.
5. Place the cursor anywhere on the document.
If you have any questions, call Microsoft Word support.
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QuarkXPress ® 3.1–3.3

1. Open an existing QuarkXPress document.
2. Select the desired picture box tool from the toolbox.
3. Create a picture frame by dragging and dropping the mouse in the desired size
and area of the page.
4. Choose File—Get Picture .
5. In the dialog box that appears, change the drive and directory to locate the
image. All of the images for the Kudo Catalogs are located on the Expert CD.
6. Select the image you want to use and click on the OK button.
7. Place the cursor anywhere on the document.
If you have any questions, call QuarkXPress technical support.

WordPerfect ® 6.0

1. Open an existing WordPerfect document.
2. Choose Graphic—Figure—Retrieve .
3. In the dialog box that appears, change the drive and directory to locate the
image. All of the images for the Kudo Catalogs are located on the Expert CD.
4. Select the image you want to use and click on the OK button.
5. Place the cursor anywhere on the document.
If you have any questions, call WordPerfect support.
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Adobe ® PageMaker ® for Windows

1. Open an existing PageMaker document or choose File—New .
2. Choose File—Place .
3. In the dialog box that appears, change the drive and directory to locate the
image. All of the images for the Kudo Catalogs are located on the Expert CD.
4.Select the image you want to use and click on the OK button.
5. Place the cursor anywhere on the document, then click.
If you have any questions, call PageMaker technical support.

Harvard Graphics ® for Windows

1. Create a Harvard Graphics presentation or open an existing presentation.
2. Choose File—Import.
3. In the dialog box that appears, choose a file format from the File Format drop-
down list.
4. Change the drive and directory to locate the Kudo Catalog image file category
on the CD.
5. Select the image you want and click on the OK button.
If you have any questions, call Harvard Graphics technical support.
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Frequently Asked Questions

This is a general section on possible situa-
tions that may arise while using the Kudo
Catalog Reader. Frequently asked user ques-
tions are also included.

Using a Kudo Catalog Reader 
Q: The thumbnails look poor in quality. What can I do to improve the way
they appear?

A: You probably are using a 8-bit video driver ( 256 colors ). Like viewing Apple
QuickTime movies or MS AVI movies, the more colors displayed, the smoother
and clearer the image will be. Set your video card for a higher color display 16-bits
or higher ( 32K, 64K, or 16.7M colors ). Changing video color modes requires you
to restart Windows. Don’t forget to save your work first.
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Q: When I double-click on a thumbnail, nothing happens or I get a "no
launch extension found for this file" message. What should I do? 

A: You do not have an application associated with this image or media type.
Windows 3.x and NT use the File Manager to set associations while Windows 95
uses the Explorer disk drive menus.

In Windows 3.x or NT, you will need to open File Manager. Then, choose File—
Associate . In the dialog box which appears, enter in a new extension (or modify
an old one) and assign it to an application.

In Windows 95, open the Explorer and choose the View—Options . In the Options
dialog box, select the File Types tab. Pick an image file type and click on the Edit
button to modify the application that is linked to this extension.

Note: Please consult your Window’s operating system manuals for additional infor-
mation and help.

Q: I am having problems printing my catalogs. What can I do?

A: You probably have an incompatible printer driver installed. Try to install a more
generic printer driver (a driver that has a larger printer group support - consult
your printer documentation). Kudo applications direct calls to standard Windows
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printer drivers. If you are using a laser printer, try using the HP LaserJet II printer
driver; most printers support it. For Dot Matrix printers, a common driver is the
Epson FX-80 or LQ-80.

Q: My thumbnail will not drag and drop into my application. What is happen-
ing?

A: In order to drag and drop thumbnails into other applications, the application
must be OLE 2.0 compliant. If the application you are trying to drag and drop into
is not OLE 2.0 compliant or Kudo does not have a Place Module for it, it may not
work. Many applications can still receive information via drag and drop, but may
only be able to access them through a specific location on the screen. This area is
the application Title bar ( i.e. Microsoft Word, Corel DRAW!, Pagemaker, etc. ) at
the top of the program.You can tell that you are allowed to drop a thumbnail onto
an application when the cursor turns into a box with an arrow.

Q: Nothing happens when I drag and drop a thumbnail into a PageMaker or
QuarkXPress document. What am I doing wrong?

A: When an image type is not supported by the target application, the application
tends to ignore it (or do other unpleasant things; i.e. you can drag and drop into
Excel, but Excel will try to open the image file as a worksheet and it will fill all the
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data cells with junk). Check the kind of thumbnail you are using; it must be an
image type supported by the version of Pagemaker or QuarkXPress you have
installed on your computer.

Q: Why are there grayed-out commands?

A: The Kudo Catalog Reader provided on the CD is a Read Only version of Kudo
Publisher. It only contains those commands needed for using the catalog reader.

Q: Why doesn’t the Kudo Catalog Reader save any of the text changes I
made?

A: The Kudo Catalog Reader provided on the CD is a Read Only version of Kudo
Publisher. It only contains those commands needed for using the catalog reader.

Q: What should I do when I get the Find Image dialog box after choosing
Image—Display Original?

A: Place the letter of your CD-ROM drive in the text field and then press the Enter
key. This dialog appears when the Kudo Catalog Reader is not sure where the
original CD images are located.
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Q: Are there any shortcuts for the menu commands?

A: The following list contains all Keyboard Short Cuts for the program.

File Men u
Open Ctrl+O

Close Ctrl+W

Print Ctrl+P

Exit Alt+F4

Edit Men u
Copy Thumbnail Ctrl+C

View Menu
Small Gallery Ctrl+S

Gallery Ctrl+G

List Ctrl+L
Image Menu
Display Original Ctrl+E

Get Info Ctrl+I

8487pdf.qxd  4/2/96 4:30 PM  Page 46



Page 47

Find Ctrl+F

Find All Ctrl+A

Help Men u
Index F1



About
Adobe PageMaker for

Windows
Arrange Icons
Cascade
Close
Close All
Copy and Paste
Copy Thumbnail
Copyrights and

Trademarks
Credits
Display Original
Document List
Drag and Drop
Edit Menu
Exit
File Menu
Find

Find All
Find Button
Frequently Asked

Questions
Gallery View
Gallery View Button
Get Info
Harvard Graphics for 

Windows
Help Menu
Image Information
Index
Info Button
Installing TrueType Fonts 

in Microsoft Windows
3.1

Installing TrueType Fonts
in Microsoft Windows 95
Kind

Kudo Catalog Reader
License Statement
List View
List View Button
Location Notes
Menu Bar
Microsoft Word 6.0 and 

7.0
Microsoft Word Pad
Microsoft Write
Modification Date
Name
Print
Printer Setup
Printing Catalogs
Product Support 
QuarkXPress 3.1-3.3
Riffle Feature
Shortcuts

Size
Small Gallery View
Small Gallery View

Button
Sort Menu
Status Bar
Thumbnail
Thumbnails Gallery
Tile
Tutorial
Using Help
Using Kudo Catalog 

Reader
Using the Images in 

Various Applications
View Menu
Window Menu
WordPerfect 6.0

Index
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Expert Software License Statement 
This software is protected by both United States Copyright Law and International Treaty provisions. Expert Software, Inc. grants you this license and your
continued use confirms your agreement. Therefore, you must treat the software “just like a book,” with the following single exception: Expert Software,
Inc. authorizes you to make archival copies of the software for the sole purpose of backing up your software and protecting your investment from loss.
By saying “just like a book,” Expert Software, Inc. means, for example, that the software may be used by any number of people and may be freely moved
from one computer to another, so long as there is no possibility of being used at one location while it’s being used in another. This is just like a book that
cannot be read by two different people in two different places at the same time; neither can this software be used by two different people in two different
places at the same time.
This agreement shall be construed, interpreted, and governed by the laws of the state of Florida and shall inure to the benefit of Expert Software, Inc. its
successors, administrators, heirs, and assigns. 
Limited Warranty
Limited warranty on product disks. To the original buyer only, Expert Software, Inc. warrants the disk or disks on which this product is recorded to be free
of defects in material and workmanship under normal use for a period of 90 days from the purchase date. Any implied warranties of merchantability or fit-
ness for a particular purpose are limited in duration to the period of 90 days from the date of purchase. Your sole and exclusive remedy in the event of a
defect in material or workmanship under normal use is expressly limited to replacement of the defective item.
This warranty gives you specific legal rights, and you might also have other rights which vary from state to state.
No warranty on product software or User’s Guide. Even though Expert Software, Inc. has tested the software and User’s Guide and reviewed their con-
tents, Expert Software, Inc. and its distributors and dealers make no warranties, either expressed or implied, with respect to the fitness for a particular
purpose. The software and User’s Guide are distributed solely on an as is basis. The entire risk as to their quality and performance is with you. Should
either the software or User’s Guide or both prove defective, you (and not Expert Software, Inc. and its distributors and dealers) assume the entire cost of
all necessary servicing, repair, or correction. Expert Software, Inc. and its distributors and dealer will not be liable for direct, indirect, incidental, or con-
sequential damages resulting from any defects in the software or User’s Guide, even if they have been advised of the possibility of such damages.
Some states do not allow limitations on how long an implied warranty lasts or the exclusion or limitation of incidental or consequential damages, so the
above limitations or exclusions might not apply to you.
Copyright
© 1996 Expert Software, Inc. All Rights Reserved.  All Rights Reserved Worldwide. The user’s guide and the software described in it are copyrighted with
all rights reserved. The user’s guide or software may not be copied in whole or part, without written consent of Expert Software, Inc. You may not sell,
rent, lease or transfer copies of the user’s guide or software in any other way without the prior written consent of Expert Software, Inc.
Trademarks
Expert Software and the Expert brand logo are trademarks of Expert Software, Inc. Microsoft and Windows are registered trademarks of Microsoft Corp.
Macintosh is a registered trademark of Apple Computer Inc. All other trademarks are acknowledged.
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Expert Product Support Policy
Your purchase of an Expert product includes free product support to help you get the most out of your software. All Expert products are thoroughly test-
ed and come with a user’s guide and/or help file. In most cases, the answer to many of your questions are in this guide and/or the help file.
If you are having problems starting or running the program, please feel free to give us a call. We can be reached at (305) 567-9996, Monday through
Friday, 9:00AM to 5:00PM EST (Eastern Standard Time).
When you call, you should be at your computer. Be ready to give the Product Support Specialist the 10-digit program version number from the front of
your program disk or back of the CD jewel case, as well as the following information:
If you have a Macintosh–compatible computer:
• Please have the model, system software version and amount of memory available.
If you have Windows– or MS-DOS–compatible computer:
• The version of DOS that is installed on your computer. (You can determine the version by typing VER at the DOS prompt.)
• The version of Windows® installed on your computer.
• The type of hardware you are using:

1. The brand of computer you own, 
2. CPU type (80386, 80486, Pentium), 
3. Video type (EGA, VGA, Super VGA),
4. Model and type of video card, and 
5. Model and type of printer.

• The exact wording of any messages that appeared on the screen.
• What happened and what you were doing when the problem occurred.
• We encourage Windows® (or MS-DOS 6.x) users who need product support to print an MSD report. Have it available for the Product Support Specialist

who answers your call. You will find the MSD (Microsoft Diagnostics) program in either the Windows or the DOS directory.
In case of defective disks
If the disk or disks should fail within 90 days of purchase, please return the original disk with proof of purchase for FREE replacement. After 90 days
from date of purchase, please include $9.50 for replacement. You can obtain a replacement disk of the program by returning the defective copy, and
your proof of purchase to Expert Software, Inc. Attention: Customer Service, P.O. Box 144506, Coral Gables, FL 3114-4506.
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